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ABSTRACT 
 
 

 A soldier on a mission is more likely to face many obstacles and hard times. 

During such situation they should get necessary help. Help may in the form of 

backup or immediate medical attention. The primary requirement to help is to 

know the exact location of the soldier. Considering this a design of utility jacket 

for the soldiers is done. The utility jacket is embedded with sensors, 

microcontroller and communication device to achieve this goal. The utility jacket 

is designed to provide immediate first aid by sensing soldier’s health vitals and 

also provides means to track and monitor their location. Microcontroller controls 

the sensors and communication devices. Jacket consists of temperature sensor to 

monitor the body temperature of soldier. Cloud server is used to store the soldier’s 

location and health vitals. Android application is used to monitor the data 

generated from the jacket. Using the application, every soldiers are able to see the 

position of every other soldiers who are in the same mission. A soldier can 

manually call for help by using SOS service provided in the application. Every 

soldiers will be monitored by the base station and backup or medical team will be 

sent to the location of needy soldier. A soldier can sense nearby soldier if he needs 

any help. The base station can specify the destination location. The application also 

includes the geo-fence feature that alerts when the soldier moves from one location 

to another location. The regions are separated by circle on the map and enemy 

region is covered by red circle. This helps the soldier to realize in which region 

they currently are. Hardware module with its android application is experimented 

and found working correctly. The module will be surely helpful to the defence of 

the Nation. 
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CHAPTER 1  

INTRODUCTION 

 

 The Department of Defence Production of the Ministry of Defence is 

responsible for the indigenous production of equipment used by the Indian Armed 

Forces. The Government of India has launched Make in India initiative to 

indigenise manufacturing and reduce dependence on imports, including defence 

imports and procurement. The defence assistance system is one of the initiative to 

provide a better defence system to the country so that the soldiers are provided 

with a better support during the security duty. Basically the health condition of the 

soldiers are not know until he is checked physically and the base camp is unaware 

of the location of the soldier accurately. This defence assistance system is aimed at 

providing the health condition and exact location of the soldier simultaneously to 

the base camp and alert them when there is an emergency. Hence in monitoring the 

health condition and location ,the Heartrate sensor, temperature sensor and GSM 

SIM 808 are employed and the information collected is provided to the Cloud 

which in turn provides the information to the base camp .  This system provides 

vital help to serve the soldiers better in critical situation and  in case of emergency. 

With the advancement in the technology of Internet of Things these transmission 

of the data is made possible with ease. The Internet of things (IoT ) is the inter-

networking of physical devices, vehicles (also referred to as "connected devices" 

and "smart devices"), buildings, and other items—embedded with electronics, 

software, sensors, actuators, and network connectivity that enable these objects to 

collect and exchange data. This data of the soldier that is collected is also stored in 

the cloud for future reference and use. 
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CHAPTER 2 

LITERATURE SURVEY 

2.1 EXISTING SYSTEM 

 In the current system the soldiers are monitor and all the requirements 

during the mission are provided by the base station. The soldier’s health vitals are 

monitored periodically. In case of medical emergency, the backup team is notified 

through text message or wireless telecommunication. Soldier’s geographical 

location is specified in the message for the backup team to reach. Soldiers can view 

the destination on their local device which is specified by the base camp. 

2.2 LITERATURE SURVEY 

 The author says [11] how the semantic data model is proposed to store and 

interpret IoT data. Then a resource-based data accessing method (UDA-IoT)is 

designed to acquire and process IoT data ubiquitously to improve the accessibility 

to IoT data resources. Finally, we present an IoT-based system for emergency 

medical services to demonstrate how to collect, integrate, and interoperate IoT data 

flexibly in order to provide 

Support to emergency medical services. The result shows that the resource-based 

IoT data accessing method is effective in a distributed heterogeneous data 

environment for supporting data accessing timely and ubiquitously in a cloud and 

mobile computing platform. It also deals with the activities and roles in medical 

system, Meta data models and big data. 
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ADVANTAGES  

• It is reliable and flexible. 

• It is highly efficient in remote accessing of data. 

• Heterogeneous data collection and processing. 

DISADVANTAGES 

• No live monitoring of patient‘s data 

• High maintenance cost. 

In modern health care environment[12], the usage of IoT technologies brings 

the patients applied to various medical areas (such as real-time monitoring, patient 

information management, and healthcare management). The body sensor network 

(BSN) technology is one of the core technologies of IoT developments in 

healthcare system, where a patient can be monitored using a collection of tiny-

powered and lightweight wireless sensor nodes. However, development of this new 

technology in healthcare applications without considering security makes patient 

privacy vulnerable. There are lots of security requirements in BSN based modern 

healthcare system. Subsequently, a secure IoT based healthcare system using BSN, 

called BSN-Care, which can efficiently accomplish those requirements. 

ADVANTAGES 

• It provides data security. 

• Faster in data processing. 

 

DISADVANTAGES 

• No emergency decision support.  

• Each patient must be monitored separately that consumes more time. 
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 An efficient vehicle tracking system is designed and implemented for 

tracking the movement of any vehicle from any location at any time. This system 

[13] made good use of a popular technology that combines a Smartphone 

application with a microcontroller. This will be easy to make and inexpensive 

compared to others. The designed in-vehicle device works using Global 

Positioning System (GPS) and Global system for mobile communication / General 

Packet Radio Service (GSM/GPRS) technology that is one of the most common 

ways for vehicle tracking. The device is embedded inside a vehicle whose position 

is to be determined and tracked in real-time.. The vehicle tracking system uses the 

GPS module to get geographic coordinates at regular time intervals. The 

GSM/GPRS module is used to transmit and update the vehicle location to a 

database. A Smartphone application is also developed for continuously monitoring 

the vehicle location. The Google Maps API is used to display the vehicle on the 

map in the Smartphone application. Thus, users will be able to continuously 

monitor a moving vehicle on demand using the Smartphone application and 

determine the distance and time for the vehicle to arrive at a given destination.  

 

 

ADVANTAGES  

• Live monitoring of vehicle position. 

• Easy to install and reliable. 

DISADVANTAGES 

• Difficult of working in rural areas.  
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CHAPTER 3 

PROJECT DESCRIPTION 

 

3.1 Problem Definition 

During a mission, soldiers are in life or death situation. Close attention needs 

to be given for their wellness. Their health vitals need to be monitored 

periodically. Critical decisions must be taken to ensure the safety of a soldier. 

In the existing system the tracking of the solders health condition are in 

complex state. In case of medical emergency, the backup team is notified 

through text message which takes longer time for the backup team to reach the 

destination and finding the location are more difficult.  Local support - Indian 

Army is fighting a strange war where we have to fight on our own territory. 

That means lot of local support is required. The support from local populace 

against army is one of the biggest problems in any operation. No one has our 

back. The mission head are in the situation to identify the injured and informed 

to the base station it reduces the effect of the mission. 

3.2 Project Description 

Defense Utility jacket system assists the soldiers keep track of each soldier 

and their health vitals such as heart rate, body temperature. After gathering all 

the information the details are sent to the base station. In base station each and 

every soldier’s health conditions are monitored.  When the soldier’s body 

temperature goes down the normal temperature, an alert message will send to 

the base station and the medical team will arrive to the soldier’s location. The 

GPS module is used to know every soldiers location. Heating pad is used when 

the body temperature goes down it will automatically maintain the temperature.  

When the soldiers enter into the enemy region a waning message will send to 

the soldier there is an help button. Then all the soldiers will arrive to the soldier 

location by using their location module. The location detail is send periodically 
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to the base camp with geographical location of a soldier. A soldier can keep 

track of other soldiers who are on the same mission. All soldiers contain an app 

in that their health vitals and locations are displayed.  The soldiers will know 

other soldiers location in the same mission.  This application provides graphical 

interface and helps the observer in the base camp to visualize the soldier’s 

health condition and their location. It will show different region partitions and 

the data’s are stored in the cloud servers.  

 

3.3 Block Diagram 

 

Fig 3.1 Block Diagram for Defense Utility Jacket 

The above block diagram represents the operations or the functions 

performed by the Defense Utility Jacket. Mini Computer acts as the base of the 

system where it controls the overall system input, output, operations etc. 
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3.4 Module Description 

 There are three modules in the Defense utility jacket which carries out the 

overall functionality and the operations of solders. 

� Health Monitoring  

� Position Tracking  

� Base Camp 

 

3.4.1Health Monitoring 

This module continuously monitors the health vitals of the solders such as 

temperature and pulse rate. Body Sensor Network (BSN) allows the integration of 

intelligent and uses low-power sensor nodes around human body to monitor body 

functions and the surrounding environment. This also consists of in-body sensor 

network allows communication between invasive/implanted devices and base 

station. Each sensor node is integrated with biosensors such as Temperature, Blood 

Pressure (BP), etc. These sensors collect the physiological parameters and forward 

them to a coordinator called Local Processing Unit (LPU), which can be a portable 

device such as PDA, smart-phone etc. This data’s are then transmitted to base 

station and stored in the cloud platform.  

 

 

3.4.2 Location Monitoring  

 The basic purpose of a location tracking system is to track a specific target 

or other objects. The tracking device is able to relay information concerning the 

current location of the solders. This system consists of an electronic device as 

usually installed in the component and can be used for tracking the position of each 

solder. This system generates the geographic coordinates and a unique ID from a 

device in real time using the GPS module. Transmission of a solders location 
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information and an ID to a web server after a specified time interval using the 

GSM/GPRS module. Database is designed to store and manage received solders 

location information whenever the location is required, it can be accessed from the 

database and monitored on Google maps in real-time using a Smartphone 

application. 

3.4.3 Base Camp 

Base Station manages all the inputs and the data received from the remote 

solders. Under processing unit there are Mini Computer, NRF24L01 transceiver, 

Wi-Fi USB dongle to connect with internet. Base Station consists of the cloud 

based database which stores all the details of the solders location, health condition, 

etc. The received value is checked based upon the condition and when the critical 

conditions occurred it sends the backup team to the appropriate location. The base 

station contains medical team. The medical team will monitors all the soldiers’ 

health condition and their geographical location. When the soldier in a critical 

situation the medical will arrive to the soldier location for helping and the base 

station is connected to the soldier’s mobile app. The data’s are stored   in cloud 

server. By using that server the data’s are transfer from soldier to base station by 

http request. 
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3.5 Flow Diagram 

 

Fig 3.5.1 Soldier Flow Diagram 

 In this soldier flow diagram the heart rate and the temperature  is collected 

using sensors and the latitude and longitude information are then collected from the 

GPRS, then this data is provided in the decision making section ,and the decision is 

made whether to provide help to the soldier or not and then the data is stored in the 

server. 
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Fig 3.5.2Base Camp Flow Diagram 
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 In the base camp flow diagram, the mission id and the soldier id is 

provided and checked to get logged in the geo-fence application. Once the 

login is activated the map is initialised with the location and then the 

connection with the cloud is established and then the information of the 

soldier is collected and displayed. This information provides the SOS call if 

the soldier position is specified in RED, otherwise if it is GREEN the 

mission is carried on as specified. This is updated in the database and then 

the decision of carrying on the mission or stopping the mission is taken. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



17 
 

CHAPTER 4 

HARDWARE DESCRIPTION 

 

4.1Arduino UNO 

 Arduino board designs use a variety of microprocessors and controllers. The 

boards are equipped with sets of digital and analog input/output (I/O) pins that may 

be interfaced to various expansion boards and other circuits. The boards feature 

serial communications interfaces, including Universal Serial Bus (USB) on some 

models, which are also used for loading programs from personal computers. The 

microcontrollers are typically programmed using a dialect of features from the 

programming languages C and C++. In addition to using traditional compiler tool 

chains, the Arduino project provides an integrated development environment (IDE) 

based on the Processing language project. Arduino microcontrollers are pre-

programmed with a boot loader that simplifies uploading of programs to the on-

chip flash memory. The default boot loader of the Arduino UNO is the opti-boot 

boot loader. Boards are loaded with program code via a serial connection to 

another computer. Some serial Arduino boards contain a level shifter circuit to 

convert between RS-232 logic levels and transistor–transistor logic (TTL) level 

signals. Current Arduino boards are programmed via USB, implemented using 

USB-to-serial adapter chips such as the FTDI FT232. 

 

Fig 4.1 Arduino UNO 

 



 

4.2 89AD LM35 DZ Temperature Sensor

 Temperature is the degree of hotness of the body which is a measure of the 

heat content in the body. Temperature Sensor is used to

heat energy or even coldness that is generated by an object or system, allowing us 

to “sense” or detect any physical change to that temperature producing either an 

analogue or digital output.

temperature sensor or switch which basically consists of different metals such as 

nickel, copper, tungsten or aluminium

a Bi-metallic strip  which helps in finding the temperature. The different linear 

expansion rate of the two dissimilar metals produces a mechanical bending 

movement when the strip is subjected to heat.

itself as an electrical switch or as a mechanical way of operating an electrical 

switch in thermostatic contr

heating elements in boilers, furnaces, hot water storage tanks as well as in vehicle 

radiator cooling systems. 

Fig 4.2 89AD LM35 DZ Temperature Sensor 
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89AD LM35 DZ Temperature Sensor 

Temperature is the degree of hotness of the body which is a measure of the 

Temperature Sensor is used to measure 

heat energy or even coldness that is generated by an object or system, allowing us 

to “sense” or detect any physical change to that temperature producing either an 

analogue or digital output. The thermostat is a contact type electro

temperature sensor or switch which basically consists of different metals such as 

aluminium etc. This metals are bonded together to form 

which helps in finding the temperature. The different linear 

on rate of the two dissimilar metals produces a mechanical bending 

movement when the strip is subjected to heat. The bi-metallic strip can be used 

itself as an electrical switch or as a mechanical way of operating an electrical 

switch in thermostatic controls and are used extensively to control hot water 

heating elements in boilers, furnaces, hot water storage tanks as well as in vehicle 

 

89AD LM35 DZ Temperature Sensor  

 

 

Temperature is the degree of hotness of the body which is a measure of the 

 the amount of 

heat energy or even coldness that is generated by an object or system, allowing us 

to “sense” or detect any physical change to that temperature producing either an 

is a contact type electro-mechanical 

temperature sensor or switch which basically consists of different metals such as 

etc. This metals are bonded together to form 

which helps in finding the temperature. The different linear 

on rate of the two dissimilar metals produces a mechanical bending 

metallic strip can be used 

itself as an electrical switch or as a mechanical way of operating an electrical 

ols and are used extensively to control hot water 

heating elements in boilers, furnaces, hot water storage tanks as well as in vehicle 
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4.3 Pulse Rate Sensor 

To measure the heart rate first step is to detect the heart beat/pulse and count 

the beats per minute. So in order to detect the pulse we will pass the light (using an 

LED) from one side of the finger and measure the intensity of light received on the 

other side (using an LDR). Whenever the heart pumps blood more light is absorbed 

by increased blood cells and we will observe a decrease in the intensity of light 

received on the LDR. As a result the resistance value of the LDR increases. Unlike 

the electrocardiogram (ECG) a doctor might use to measure the heart rate.  An 

LED shines through the skin, and an optical sensor examines the light that bounces 

back. Since blood absorbs more light, fluctuations in light level can be translated 

into heart rate – a process called photo plethysmography. Using an optical heart 

rate monitor on the wrist just isn’t as accurate as using one on the fingertip or on 

the chest. The chest-worn models more closely mimic an EKG machine. It requires 

power supply, DC: 3.6V-6.0V. It works under Baud rate of (9600*N) bps, N=1-12 

(default 57600bps). It has a file size of 256 bytes. 

 

 

Fig 4.3 Pulse rate Sensor 

 

 



 

4.4 GSM Module 

 It is an ultra-compact and reliable wireless module. The SIM

complete Dual-band GSM/GPRS solution in a 

embedded in the customer applications.

the SIM800A delivers GSM/GPRS 900/1800MHz performance for voice, SMS, 

Data, and Fax in a small form factor and with low power consumption. With a tiny 

configuration of 24mmx24mmx3mm, SIM

requirements in user applications, especially for slim and compact demand of 

design. It is controlled by AT commands enhanced by SIMCOM. 

Fig
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compact and reliable wireless module. The SIM

band GSM/GPRS solution in a SMT module which can be 

embedded in the customer applications. Featuring an industry-standard interface, 

00A delivers GSM/GPRS 900/1800MHz performance for voice, SMS, 

Data, and Fax in a small form factor and with low power consumption. With a tiny 

configuration of 24mmx24mmx3mm, SIM800A can fit in almost all the space 

requirements in user applications, especially for slim and compact demand of 

It is controlled by AT commands enhanced by SIMCOM.  

 

Fig. 4.4 GSM Module SIM800 

 

 

 

compact and reliable wireless module. The SIM800A is a 

SMT module which can be 

standard interface, 

00A delivers GSM/GPRS 900/1800MHz performance for voice, SMS, 

Data, and Fax in a small form factor and with low power consumption. With a tiny 

00A can fit in almost all the space 

requirements in user applications, especially for slim and compact demand of 
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CHAPTER 5 

SOFTWARE DESCRIPTION 

 

5.1 Arduino IDE 1.6.7 

The Arduino Integrated Development Environment - or Arduino Software 

(IDE) - contains a text editor for writing code, a message area, a text console, a 

toolbar with buttons for common functions and a series of menus. It connects to the 

Arduino and Genuino hardware to upload programs and communicate with them. 

Writing Sketches 

Programs written using Arduino Software (IDE) are called sketches. These 

sketches are written in the text editor and are saved with the file extension .ino. 

The editor has features for cutting/pasting and for searching/replacing text. The 

message area gives feedback while saving and exporting and also displays errors. 

The console displays text output by the Arduino Software (IDE), including 

complete error messages and other information. The bottom right-hand corner of 

the window displays the configured board and serial port. The toolbar buttons 

allow you to verify and upload programs, create, open, and save sketches, and open 

the serial monitor. 

Uploading 

Before uploading the code into the sketch, it is important to select the correct 

items from the Tools > Board and Tools > Port menus. The boards are described 

below. On the Mac, the serial port is probably something 

like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) 

or /dev/tty.usbserial-1B1,or/dev/tty.USA19QW1b1P1.1 (for a serial board 

connected with a Key span USB-to-Serial adapter). On Windows, it's 

probably COM1 or COM2 (for a serial board) or COM4, COM5, COM7, or higher 

(for a USB board) - to find out, you look for USB serial device in the ports section 

of the Windows Device Manager. On Linux, it should 
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be /dev/ttyACMx,/dev/ttyUSBx or similar. Once you've selected the correct serial 

port and board, press the upload button in the toolbar or select the Upload item 

from the File menu. Current Arduino boards will reset automatically and begin the 

upload. With older boards (pre-Diecimila) that lack auto-reset, you'll need to press 

the reset button on the board just before starting the upload. On most boards, you'll 

see the RX and TX LEDs blink as the sketch is uploaded. The Arduino Software 

(IDE) will display a message when the upload is complete, or show an error. 

The program uploading is done using the Arduino bootloader, a small 

program that has been loaded on to the microcontroller on your board. It allows 

you to upload code without using any additional hardware. The bootloader is active 

for a few seconds when the board resets; then it starts whichever sketch was most 

recently uploaded to the microcontroller. The bootloader will blink the on-

board(pin 13) LED when it starts. 
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Fig 5.1 New Sketch Screen 

 

Fig 5.2 Uploading Sketch 
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CHAPTER 6 

RESULTS 

 

Table 6.1 EXISTING SYSTEM VS PROPOSED SYSTEM 

S.NO PARAMETERS EXISTING 
SYSTEM 

DEFENSE UTILITY 
JACKET 

1 Method   Manual  Automatic 
2 Time More time 

consuming 
Less time consuming 

3 
 

Storage Stored locally Stored in cloud 

4 
 

Communication wireless GPRS protocol 

5 Data transmission When required Every 10 Seconds 
 

 

The above table describes the comparison of the existing system and the 

proposed system. The existing system is not automatic and requires a large amount 

of manpower. The facility of storing is also not easy since it requires more servers, 

and also requires large amount of memory. The proposed system is automatic, 

manpower is eradicated to a greater extent and the storage is based on the memory 

specified which can stored in cloud and reduces the time consumption.   
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SCREENSHOTS 

BASECAMP MISSION CREATE ACTIVITY 

 

   

        Fig 6.1 Mission Creation                Fig 6.2 Destination and Radius 

 

 

 The base camp mission create activity consists of two activities the mission 

creation activity and the destination specification activity. 

 The mission creation activity is used to start a new mission and specify it to 

the soldiers immediately using the geo-fence application. 

  The destination and radius is used to specify the exact location of the 

mission operation and the radius within which the mission has to be carried on  
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BASECAMP MAP ACTIVITY 

 

Fig 6.3 Map Activity 

 In the Fig6.3,the location of the soldiers along with the base camp location is 

visualised and based on this information the instructions are provide to the soldier. 

 

SOLDIER LOGIN ACTIVITY 

 

 

Fig 6.4 Soldier Login 
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SOLDIER MAP ACTIVITY 

 

     

  Fig 6.5 Soldier Map Activity                                 Fig 6.6 Soldier SOS call 

 
 In the soldier login Fig 6.4 the soldier id and the mission id is specified to 

login the soldier into the mission. With the help of this geo-fence app the soldier 

could be provided with the location information of the other soldiers and the 

location of the base camp and the destination and the radius of the mission if 

specified. 

 The SOS function can be called automatically when there is a medical 

emergency and can also be called manually by the soldier using the SOS button. 

Once the function is called the location mark of the soldier is turned RED, thus 

indicating an emergency situation.  
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CHAPTER 7 

CONCLUSION  

 

This system is a small contribution for a fair Defense, which helps to 

monitor each soldier’s health conditions. The automation of system with reduction 

in manpower and time consumption helps the government. It helps the Defense to 

succeed in their missions and preventing the soldier’s life. The position of the each 

member increases the range and accuracy in their attacks, which reduces the injury 

that happens in the field and even in case of distress it can be easily tracked and 

necessary actions, can be taken. 

 

 FUTURE ENHANCEMENTS 

 

 This system can be improved with some additional functionality like, 

• Use of satellite to identify the location and live monitoring of Mission. 

• Server based system where one base camp can access the entire solders 

machine across the Mission Day. This will reduces the cost and uses a single 

database to store all the details. 

• Use of touch pad with micro boards to reduce in size and easy to carry. 
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